EXEMPLO

SEQUENCIAMENTO
Tecla F1 - HELP
Tecla F5 — executa o método

v - valida o cédigo



1)
2)
)

4
5)

Roteiro de construg¢ao do

exemplo de sequenciamento
Importacao dos dados (importando pedido):
construir tabela de dados: numero do pedido, data
devida e tempo de processamento;

Tratamento dos dados (organizando pedidos);

Liberacao dos dados para o Sorfer (transferindo
pedidos para o Sorter);

Processamento dos pedidos no Single Proc;

Saida — Drain — resultados alcancados (por
exemplo: tempo total para o atendimento dos

pedidos ou atraso total). )



1) IMPORTACAO DOS DADOS —
pedidos (cod_pedido) — 100 pedidos

DADOS ALEATORIOS DO EXCELL

Tempos de processamento: (5 — 60) — variacao por
pedido de 5 a até 60 minutos (tempo_proc)
Data devida: (0 — 6) — variacao por pedido de O (data de
hoje) até 6 dias — intervalo de tempo de 1 semana
(data_entrega)

Boas praticas de programacao
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Column width: 20
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Range: {11
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Console v @x
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S Framel (175%) X o
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-[® Filenterface
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1° Método
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1° Método

IMPORTACAO DOS DADOS
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Método para importagao de dados

1) Método — (importacdo dos dados para a Tabela eo
tratamento dos dados na Tabela

IS
linhas : integer; S, .
. < Varlavels
| :integer;
do
--importa dados do excel & Comentarios

tf_entrada.readExcelFile("Pedidos.xlIsx");

< Dimensao em linhas
--tratar os dados

linhas := tf entrada.YDIm - 2; .
- <12 linha em branco

for i :=1 to linhas loop <2%linha Cabegalho
tf_dados[1,i] := str_to_Num(tf_entrada[1,i+2]); --cod_produto
tf dados[2,i] := str_to_Num(tf_entrada[2,i+2]); --tempo_proc (min)
tf _dados[3,i] := str_to_Num(tf_entrada[3,i+2]); --data_entrega
next; [coluna (y), linha (i)]

end:; 66
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-1, Trigger 4 do
¥ Generator 2 5 --importa dados do excel
-8 AttributeExplorer T 6 tf_entrada.readExcelFile("Pedidos.xlsx");
FileLink 7
-[% Filelntedface 8 --tratar os dados
™ XMUrterface g linhas := tf_entrada.YDim - 2;
~8_ Teamcenter 16
& ODEC 11 for 1 := 1 to linhas loop
-8% SQlite 12 tf_dados[1,i] : to_lum(tf_entrada[1,i+2]); --cod_produte
£° OracleSi 13 tf_dados[2,1] _Num(tf_entrada[2,i+2]); --tempo_proc (min)
-8 Oracle10g 14 tf_dados[3,i] : _to_Num(tf_entrada[3,i+2]); --data_entrega
& Oracle1lg 15 next;
-fR OPClnterface 16
Socket 17 end;
o ActiveX 18
[ Information_Flow
-] Userlnterface i
Favorites v 1 x
[Eramet 175%) | MMethod * x 41)
Console * I X
P
W
1 [
Ready CAP NUM SCRL

B |

PT " )
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-2 StackFie is
b QueusFile linhas : integer; +/ Apply Changes (F7)
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-1, Trigger
(¥ Genertor --importa dados do excel
-4 Attribute Explorer 6! tf_entrada.readExcelFile("Pedidos.xlsx");
FileLink
[ Flehterface --tratar os dados
™ XMLinterface g linhas := tf_entrada.YDim - 2;
8. Teamcerter
& ODBC for 1 := 1 to linhas loop
-8 SQlite 1 tf_dados[1,i] : r_to_Num(tf_entrada[1,i+2]); --cod_produto
& OracleS 1 tf_dados[2,1] r_to_Num(tf_entrada[2,i+2]); --tempo_proc (min)
-8 Oracle10g 1 tf_dados[3,i] : _to_Num(tf_entrada[3,i42]); --data_entrega
& Oraclellg 1 next;
-JR OPCinterface 1

Socket

o ActiveX
{58 Information_Flow
-] Userlnterface i

Favorites v Ix

HJE\ Add to Favorites

[Eramel (115%) | M Method* x

Console

PT K L e )
BfHnaE 3 e B w0 s
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(] MatenialFlow
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-M Method
Variable M File Edit MNavigate | Run | Template View Tools Help
TableFile o & -
2 ConFle BB e b Ba B
25 StackFie 1 is =¥ Debug FiL
H]* QueueFile 2 linhas :
-+[E TimeSequence 3 i :integ A Class Breakpoint Fa
1%, Trigger
- Generator --import]
¥ Atribute Explarer & tf_entrd sfig| switch to Debugg
- T FileLink 7
% Filelnteface E: --tratar os dados
- XMUinterface 9 linhas := tf_entrada.¥Dim - 2;
& Teamcenter 1@
& ODBEC 11 for 1 := 1 to linhas loop
& solte 12 tf_dados[1,1]
g
s

Run F3

[T}
u
i
S
=
\

do Instance Breakpoint Shift+F9

m

er F12 |5

to_Hum(tf_entrada[1,i+2]); --cod_produte
_to_Num(tf_entrada[2,i+2]); --tempo_proc (min)
‘to_Num(tf_entrada[3,i+2]); --data_entrega

-8 OracleSi 13 tf_dados[2,i] :
tf_dados[3,1i] :=

next;

Socket 17 end;

{3 Information_Flow
-] Userlnterface i

Favorites v B x

H,]B Add to Favorites

SFramel (175%) | M Method x 4 b

Console v A x

Executes the Method CAP| NUM | 5C|

1332
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BERnaBEISERE 0 o0
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-2 StackFile cod_Pedida . .
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{5 TimeSequence 1 2 3 |
A, Trigger 1 jeod_Pedido tempo_proc data_entrega
- [ Generator r -
-84 Attribute Explorer 3
FileLink —
-P% Filelnterface 4
% XMLinterface 5
& Teamcenter I3
..... 2 ODEC |
20 SQlite ——
..... £ Orace | & |
2_ Oracle10g 9
----- £~ Oraclel1g 10
[% OPClnterface m
..... Socket
= ActiveX | e |
{38 Information_Flow 13
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Favorites v ax ([ 15 ] 3
16
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17
18
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20
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Console ¥ Ix
Ermor in method *.Models Frame 1. Method' in line 12: Wrong data type for .Models.Frame 1 f_dados: real passed, string expected. o
Ermor in method ' Models Frame 1 Method' in line 6: Unknown identfier readExcelFile
Emor in method *.Models Frame 1. Method' in line 12; Wrong data type for .Models.Frame1 1f_dados: real passed, string expected.
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M Method
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TableFile s 3 | i 3 = + o
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7 CardFile
2 StackFile rod_Pedida
-+ QueueFie string Lebui ‘string -
4= TimeSequence L Open Object F2 2
- 1%, Trigger 1 fod P _prac data_entrega
& Generator = 2 ¥ cut Ctrl=X
8] Mtribute Explorer N
— 3 3 +
3 FieLinke 23 Copy Ctrl=C
I Fileinterface 8 B paste Cirl+v
- XiLinterface S 1 Delete Ctri=D
& Teamcenter 6
~& ODBC 7 SE Insert Row
-8 SQlite o
£ Oracke§ g W Insert Column
& Oracle10g 9
& Oradellg 10 Format...
[ OPCinterface
1 i 4|
Socket # Find.. Ctri+F
2 ActiveX L2
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1
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Console * B x
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1 )
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c B B « O o

CAP NUM SCRL




(2 Aula 01.spp - Tecnomatix Plant Simulation 11 - [Models.Frame1:tf dados]

File View Debugger

Tools Window Help

Class Library w» & X Toolbox

A+ Basiz (1/20)

(] MaterialFlow

(] Resources

=[] Information Flow

M Method

Tt Varisble

TableFie

i CardFile

* StackFle
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Emorin method " Models. Frame 1.Method' in line 12: Wrong data type for .Models Frame1f_dados: real passed, string expected
Emorin method . Models. Frame 1.Method' in line 12; Wrong data type for .Models Frame14f_dados: real passed, string expected
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Accessing Datain .
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Find @ Help Topici.
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Data Type forthe C...
Data Type forthe R
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User-defined Index
indexXDim

indexYDim
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New and Changed ...
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Fast index access
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Unique index key
Working with the Di..
getAttrNo

1

Column index belon...
Address Columns a...
getColumnNo

listAtIndex

Create the Work Plan

_ 3D createlndexed..

Help Menu

getRowNo

CursorY

getAitrName

setAttrType

setAttrValue

Select the Set-Up T...
Print Format

The Logical Conne...

_3D createlndexed

_30 getGraphicindex Te...
Insert a List into a C...

sql Te...
pe.[] Te
createNestedList Te..
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Reference Help > Information Flow Objects

Shared Properties of Lists and Tables > Window of Lists and Tables > Menu Bar > Format Menu

Row m Active

The menu command Row [:51 Active activates and shows the row fil[2}, i e , the header of the row, of the TableFile

0 When bath column i1 and row [iE] are active, the cell [0,0], i e, the cell at which column and row fiffS} intersect, counts as part of the column [, not as part of the row [

Models.MyPlantAnytown.MyTableFile
File Edit

[=][2 ]

Format  Navigate

= SHS HA kB aEn s P R

View Tools Help

strin strin strin strin
o g 1 g |2 . ‘3 g

string My Columnindexd My Columnindzsxl
| 1 |MyRowlndexi
| & |myRowndsxe
| 3 |MyRowindexs

MyColumnlndex2  MyColumnindex3

To access a cellin a list or table, you can either use the system m, 1

_, the number sPlant Simulafion assigns to columns and rows to access entries in a table or you can define your own user-defined m, which can be any
expression of your liking.

The advantage of a user-defined TREL over the system TR is that assigning names to columns and rows is more meaningful than the numbers Plant Simulation assigns by default. The user-defined i orders
["urgent™, "CEO"] may tell your co-modelers more than the system [l orders[3,1].

Both expressions access the same cell. The user-defined fiIEY, is more meaningful and less susceptible to errors than the system [, Another advantage becomes clear as soon as you add an additional column or row to the table:
Plant Simulation increases the system [iEEL of succeeding columns by one, while the user-defined ! remains the same and is still valid. Accessing a user-defined TiEEEL is slightly slower than accessing the system TS0,

When you select the data type Infeger you have to enter a number sign # in front of a user-defined fif[2} to distinguish it from the system ffiE

Example: orders["urgent","CEQ"];
vehicles["truck", #1];
switch["light", truel;

plant ["Chicago", .buildingl.drill]

To set the data type of the row [EE:
+ Select the menu command Row [ Active.

« Select the column for the row [l and select the menu command Format > Format. Select the data type of the row [ from the drop-down list on the tab Data Type in the dialog List Format. Depending on the data type the list
shows or hides additional text boxes or buttons. For the data types Integer, Real and String you can also enter a Format string.

To allow for quickly accessing the user-defined row [, select the check box Fast TifEY access.
To only allow unique entries in user-defined [EEEE, depending on the data type, select the check box Unique Tl key.

Related Topics
ShowRowlindex

Rowlindex
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R
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Ocuttar Voltar Home Imprimir Opgles
The menu command Row Index Active activates and shows the row index, i e , the header of the row, of the TableFile.

‘ Surnério‘ lnd\cel Pesquwsarl Favuntusl

Digite a palavra-chave para localizar: 0 When both column index and row index are active, the cell [0,0], i.e., the cell at which column and row index intersect, counts as part of the column index, not as part of the row index.

|+‘l‘ number sign, user-defined index, row

Models.MyPlzntAnytown.MyTableFile E=x e |
&, number sign

user-defined index, column File Edit Format Navigate View Tools Help
user-defined index, column example e . . o ==
Userdefined indes row = SHS BA §LangEm AP BiF
S, Dollar sign

curency, preferences
end of name string string |string ‘string

model settings 0 1 2 3
SALIGNMENT string MyColumnindssd  [MyColumnindext  MyColumnindex2  MyColumnindssa
SAUTOGROUP
SCOLOR | 1 |MyRowlndexi
SENDDATE 2 |MyRowlndexz
SFIT_TEXT_INTO_BAR —
SFONT_SIZE_BAR 3 |MyRowindexd
SFONT_SIZE_TABLE

To access a cell in a list or table, you can either use the system index, i.e., the number sPiant Simulation assigns to columns and rows to access entries in a table or you can define your own user-defined index, which can be any
expression of your liking.

SLINK
SNOCHANGEVIEW
SNONWORKINTERVAL The advantage of a user-defined index over the system index s that assigning names to columns and rows is more meaningful than the numbers Plant Simulation assigns by default. The user-defined index crders

["urgent™, "CEO"] may tell your co-modelers more than the system index crders[3,1].

SNOSAVE
SNOSTANDALONE
SORDER

Pt Both expressions access the same cell. The user-defined index, is more meaningful and less susceptible to errors than the system index. Another advantage becomes clear as soon as you add an additional column or row to the table:
SPLAUSEILITY METHOD Plant Simulation increases the system index of succeeding columns by one, while the user-defined index remains the same and is still valid. Accessing a user-defined index is slightly slower than accessing the system index.
SPLAUSIBILITY_AUTO . ) I .
SPLAUSIEILITY ORD When you select the data type Infeger you have to enter a number sign # in front of a user-defined index to distinguish it from the system index.
SPLAUSIBILITY_RES
SPROJECT_COMMENT
SRESOURCE Example: orders["urgent","CEQ"];
:ggﬁ%lﬁigé vehicles["truck", #1];
STABLE_NAME_WIDTH switch["light", truel;
STABLE_NUM_WIDTH plant ["Chicago”, .buildingl.drill]
STABLE_TITLEI
STABLE TITLE2
STIME_MARK
SZOOM

%_MU

To set the data type of the row index:
+ Select the menu command Row Index Active.

+ Select the column for the row index and select the menu command Format > Format. Select the data type of the row index from the drop-down list on the tab Data Type in the dialog List Format. Depending on the data type the list
shows or hides additional text boxes or buttons. For the data types Integer, Real and String you can also enter a Format string.

Yage_E To allow for quickly accessing the user-defined row index, select the check box East index access.
%age_F. material flow objects
}age,'lj. anawnaI flow objects To only allow unigue entries in user-defined indexes, depending on the data type, select the check box Unique index key.
“=age__!

%age_P_IP

“iage | .
“age_P_Wa Related Topics
%age_RelOccu (%_Litil)

ShowRowlindex
Rowlindex

! FormatStringRowlndex
“age 5 Wa
“%age_Stp indexYDim
%age_SU

“age T_F
Zage_T_IP e Reference Help > Information Flow Objects > Shared Properties of Lists and Tables > Window of Lists and Tables > Menu Bar > Format Menu
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Detinicoes

1) Derive

O comando Derive do menu deriva o objeto selecionado ou modelo e cria uma
Instancia da classe ativa. Qualquer mudanca realizada na classe objeto é imediatamente
refletida em sua derivada, quando o Plant Simulation estabelece uma relacéo
herdada (inheritance relation). Isto economiza tempo e eventuais problemas se vocé
quiser um numero de objetos exatamente iguais. Em vez de selecionar Derive, vocé
pode precionar (hold down) Ctrl e Shift, e dar um click no objeto que vocé deseja para
derivar uma instancia com o botdo esquerdo do mouse. Desse modo, mantendo
pressionado o botdo do mouse, arraste o objeto para o local desejado, por exemplo em
outra pasta na biblioteca de classes, e libere ambas as teclas e o botao do mouse.

2) Duplicate

O comando Duplicate do menu copia 0s objetos selecionados e cria uma nova classe.
Mudancas realizadas no objeto original ndo sdo repassadas sobre a copia que vocé
criou. Em vez de selecionar Duplicate, vocé pode acionar Ctrl e clicar no objeto que
vocé deseja duplicar com o botdo esquerdo do mouse. Entdo, acione o botdo do mouse,
arraste a copia para o local de sua escolha, o qual como uma regra deve ser em outra
pasta, na biblioteca de classes, e libere a tecla Ctrl e o botdo do mouse.
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METODOS

APILICADOS
2° Método
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2° Método

CRIAR PEDIDO DENTRO DO
SORTER
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Método para criar pedidos dentro do

1)
IS

do

end:;

Meétodo —

pedido : object;

| ;integer;

Sorter
(Criar Pedidos dentro do Sorter)

< Variaveis

Fazer para todos os pedidos = rodar a lista

for i:=1to tf_dados.YDim loop
pedido := .MUs.mu_pedido.create(Sorter);
pedido.cod_pedido :=tf dados[1,i];
pedido.tempo_proc :=tf dados[2,i];
pedido.data_entrega := tf_dados|[3,i];

next;

Sorter.sort;

Pasta — endereco — Mus.mu_pedido
Create —» cria
Sorter — local de criagdo — retorna um ponteiro para onde vai ser criado
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J)
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Consideragoes - Método

Sorter — teagrupa

Order = ascending — on acess — se organiza

Sort criterion — Method

MU property = user defined — attribute — cod_pedido
Start sorting — qual € a tuncaor — Sim — Talk: sort

¢ 0 mesmo que apertar o botao
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Console v A x
v
< )
Renames the selected object CAP NUM SCRL

L E E @me 19ftsfz;r




w2 Aula 01:spp - Tecnomatix Plant Simulation 11 - [.ModelsFramel (175%)

£ File

S5 dd @

Class Library

View Debugger

Az Basis (1/30)

(] MaterialFlow
-] Resources

=-(] Information Alow
M Method

-P=L Varizble
TableFile

- CardFile

-2% StackFle

[k QueueFile
4[5 TimeSequence
-, Trigger

- Generator
-7 Attribute Explorer
-TL FileLink

-[® Filenterface
- XMUinterace
& Teamcenter
-8 QDEBC

2" solte

~8- OracleSi

&- Oracle10g
-8~ Oracle11g

[ OPClnterface

Socket

' ActiveX
{3 Information_Flow
-] Usernterface

Favorites

\ﬂa Add to Favorites

Tools  Window Help _8x
H & e sp HE T B R 1D B D
¥ I X Toolbox vy o x
» || Material Flow | Resources | information Flow | User Inteface | Mobie: Units |
vhy = r n 'C Tl o] E @ m-’
) &2 W [ o -
DD gy b EBERBEGH - =EER = ==
g Edit Mavigate Objects Icons View Tools Help -8 X
HE s BMew 04 20 %5 7 (=)
EventController I I
Method
B2
Rename PR
tf_entrada
Mame: mtd_CriarPedido B
Label;  Pedidos Firmados =]
== B
tf dados
i framel 175%) X 30
Console v I x
W

o~
v
-

€ B 8

L.

}
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S5 Wd [EE
Class Library v I X Toolbox
A+ Basis (1/80)
-] MaterialFlow

Materizl Flow |Hesnumes I Information Flow I User Interface | Mobie Llnrtsl
#-(] Resources
-] Information Alow

./.’ | e B g B gy ) gy |
B8 r I EEBEEG
M Method

Variable g Edit Mavigate Objects Icons View Tools Help

-G X
o oo WG DMe R 0 & s mE /) ol[PfHE
-2% StackFile
-+ QueueFile
45 TimeSequence
-1, Trigger
(# Generator -

ﬂ AttributeExplorer 3 .

FileLink

% Flelnieface EventController

I XMLinterface . . . . . . .
-8~ Teamcerter Method mtd_Crla rPedido

ap 88 B R L D3 BDED D

»

" ODBC
-&° SQlite
& Oracled B
2% Oraclellg o o EE
& Oraclelig
" OFcletace tf_entrada
-on ActiveX

¥ Information_Flow
-] Userinterface

Favorites v 1 x ==
El}! Add to Favorites EE

£ Framel (175%) X 4 b

Console * I X

CAP NUM SCRL
.
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g File View Debugger Tools Window Help

5 5 HH [BEEE] R N R R el
Class Library » B X Toolbox v 3 X
Ay Basis (1/20) Material Flow |Resuurces I Information Flow I User Interface | Mobile Undsl
-1 MaterialFlow — — — — —
#-] Resources -a i-j } J.’ .;J [ ,{j}, i B @:
_D Information Flow | S S i —]

-M Method

Variable M File Edit Navigate Run Template View Tools Help

Yy O an, AR E AT

-2 StackFie 1 is

H]* QueueFile 2 dc‘

4B TimeSequence 3 end;

1%, Trigger

-l Generator

ﬂﬁﬂribme&cp\arer

- T FileLink

[* Flelnteface
- XMUinterface
Teamcenter

~87 Oracle10g
8- Oracle11g
- OPClnterface
Socket
o ActiveX
{3 Information_Flow
-] Userlnterface u

Favorites v B x

£ Framel (175%) | M mid_CriarPedido X ab

Console v A x

Ready CAP NUM 5CRL
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g File View Debugger Tools Window Help

=" K- N[=] a fB o h CTEE S
Class Library v I X Toolbox - 3 X
A Basis (1/80) Material Flow | Resources | Information Flow | User Intedface | Mobile Units |

-] MaterialFlow L2 r———
~=O0E) P AEEBEBEEC

»

#-(] Resources
=[] Information Flow

-M Method
M File Edit Navigate Run Template View Tools Help -8 X
"lﬁh'e”'e WAk sCa@d 9 AR E AR EE B
-1 CardFile
-2% StackFile 1 s
¥[» QueueFile 2 pedido : object;
45 TimeSequence 3 i :integer;
-1, Trigger 4 do
¥ Generator £ 5
-8 AttributeExplorer 7 6 for i:=1 to tf_dados.¥Dim locp
T FileLink 7 pedido := .MUs.mu_pedido.create(Sorter);
-J% Flelntedace 8 pedido.cod_pedido := tf_dados[1,1];
™ XMLinterface 9 pedido.tempo_proc = tf_dades[2,1];
-8 Teamcenter 16 pedido.data_entrega := tf_dados[3,1];
& ODEC 11 next;
~8- SQlite 12
& OracleSi 13 Sorter.sort;
8- Oracle10g 14
& Oracle1lg 15 end;
-fR OPClnterface 16
Socket
o ActiveX
[ Information_Flow
-] Userlnterface i
Favorites v 1 x
@ more )
[Eranet 175%) | M mid_ CriarPedido* % 4
Console * I X
P
W
1 [

Ready CAP NUM SCRL
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Class Library v I X Toolbox - 3 X
Material Flow |Hesnumes I Information Flow I User Inteface | Mobile Llnrtsl

e HE Y oo I R R

M File Edit Navigate Run Template View Tools Help

A+ Basis (1/80)
-] Material Flow
#-(] Resources
-] Information Alow
-M Method

»

']
]

4

]
10

[
[

o e A K %R0 nBas & %%

-2 StackFle 1 is
[+ QueueFle 2 pedido : object; Run (F5)
..g TimeSequence 3 i :integer; Executes the Method
-1, Trigger 4 do
(# Generator 5
-8 AttributeExplorer 6 for i:=1 to tf_dados.¥Dim locp
FileLink 7 pedido := .MUs.mu_pedido.create(Sorter);
-J% Flelntedace 8 pedido.cod_pedido := tf_dados[1,1];
™ XMLinterface 9 pedido.tempo_proc = tf_dades[2,1];
-8 Teamcenter 16 pedido.data_entrega := tf_dados[3,1];
& ODEC 11 next;
~8- SQlite 12
& OracleSi 13 Sorter.sort;
8- Oracle10g 14
& Oracle1lg 15 end;
-fR OPClnterface 16

Socket
o ActiveX
[ Information_Flow
-] Userlnterface

11/

n

Favorites v I x

El}! Add to Favorites

[Eranct 175%) | M mtd_CriarPedido* x 4b

Console * I X

Exerutes the Method CAP NUM | 5CRL
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N5 S HH [EE[ w S DED

v I X Toolbox
Material Flow | Resources | Infomation Flow | User Interface | Mobile: Unilsl

MaterialFlow
- 1 0 e
=+« Connector l-)-l 9 } J-b -DJ +ib o{j}» fﬂ-} fJ'J-» @:
&y EventController — = g
£ Fame
M File Edit Mavigste Run Template View Tools Help

— Souce Bk BaR 0 AR B AR

~+| Drain

- SingleProc

~2 ParsllelProc pedido :
i :integer;

57 Assembly
& DismantleStation do 7 -
@ Peideaoe Salvar o codigo

[ Store

- PlaceBuffer

&2 Buffer

& Sorter

-3 Ling

31 AngularConverter

- Converter

& Tumtable

) Tumplate

EE Track

-8 TwolaneTrack

15 / Apply Changes (F7) J

object;
J ! Applies changes to the source code

for i:=1 te tf_dados.YDim loop
pedido := .MUs.mu_pedide.create(Sorter);
pedido.cod_pedido = tf_dados[1,i];
pedido.tempo_proc f_dados[2,1];
pedido.data_entrega := tf_dados[3,1];
next;

Sorter.sort;

end;

(%] Materal_FAow
-] Resources 5

Favorites ¥ I x

f,}! Add to Favorites

Mlntd_CriarPedido* X gFramel {175%)

Console
Errorin method " Models.Frame 1.mtd_CriarPedido’ in line 7. Unknown idertifier mu_pedido

\ p 1802
PT m @ 2N A
BANABEI@ELRE v O 00

Applies changes to the source code = —
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£ File View Debugger Tools Window Help _ax
N EE JE (@ R an A2 Gk B & 523 DO D
Class Library w & X Toolbox v 4 x

A4 [EDasis (1/80) || Material Flow | Resources [ Information Flow | User Interface | Mobile Uiits |
2 MaterialFlow N — ———

(] Resources = 3 ) |+ =] o0 oS oE ER @:
-] Information Flow s =
M Method
n=1 Varizble M File Edit Navigate Run Template View Tools Help -8 x
5 Tabere Bk % Ga@ 90 MR RS
 CardFile L o
£ StackFile 1 is
A QueueFie 2 pedido : ohject;
1E TimeSequence 3 i integer;
1 Tieger 4 do ’ il ModelsFramelmtd_CriarPedido
%Genamur E 3 c £ dad 1 File Edit Mavigate Debug View Tools Help
Attribute Explorer [ or i:=1 to tf_dados.¥Dim loop - =
T FieLink 7 pedido := .MUs.mu_pedido.create(Sarter); T BE EHop ah &
% Filelnterface 8 pedido. cod_pedido 1= tf_dados[1,i]; 1 is "
™ XMLUinteface [ pad%du.tempu_pruc tf_dadus[Z,%]; 2 pedido : object;
& Teamcenter 168 pedido.data_entrega := tf_dados[3,i]; 3 i :integer;
& ODBC 11 next; 4 do
= SOlte 12 s
& Oracledi 13 Sorter.sort; E for i:=1 to tf_dados.YDim loop
&= Oracle1lg 14 7
& Oraclellg 15 end; g pedido. cod_pedido tf_dados[1,1
PR OPClnteracs 16 9 pedido.tempo_proc  := tf_dados[2,i
i Socket 16 pedido.data_entrega := tf_dados[3,1];
w ActiveX 11 next;
(3] Information_Flow 12
Q Userlnterface i 13 Sorter.sort;
Favorites - @ x B =
lﬂ! Add to Favorites Variables |Cal| S‘a:leaH Chains | Suspended | Expressians

Variable | Value

@ VoI

7 Vo

pedido vam

i 1

Unknown identifier mu_pedido
|EFanct 175 | Mmtd_Criarpedido x 1
Console v I x
Erorin methed * Models. Frame 1.mtd_CriarPedido’ in line 7 Unknown identifier mu_pedido -

v

Ready

CAP NUM SCRL|
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£ File

“T=A= K|
Class Library w & X Toolbox
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View Debugger

SR e B3
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- aXx

]
]

]
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=
-]
=
]

[
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-] MaterialFlow 2
W02 p 1 EBEEE

)

£ Fame
P Itetace
-+ Source

=+ Connectar
£ Edit

& EventController
BE @i Bk e Ra

View Tools Help

% 81 4 [l P o

MNavigate Objects Icans

| Drain

&5 SingleProc

I, ParallelProc

52 Assembly

3 DismartleStation
(& PickAndPlace
B Store

& PlaceBuffer

== Buffer

] Sore

= Line

'——\:| AngularConverter
B Convetter

& Tumtable

() Tumplate

EZ Track

B TwolaneTrack
€ FlowControl
= Cydle

{35 Materizl_Flow
-] Resources i

m

M

mtd_CriarPedido

EventController

M

Method

B—

tf_entrada

tf dados

Favorites v I X

ﬁ}! Add to Favortes

M mtd_CriarPedido gFramel 175%) X

Consale
Erorin method * Models. Frame 1.mtd_CriarPedido’ in line 7: Unknown identifier mu_pedida

Ready
VN

4 b

v 1 x

W

)
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Class Library w & X Toolbox
./:k Basis (2/80) = || Material Flow ‘ Resources | Information Flow | User Interface | Mobile Unilsl

=] MaterialFlow s
D=0 g)r b I BBEEG
& EventController — ===
£ Frame
b Inteface £ Edit Navigate Objects Icons View Tools Help I
e a0 s SMew 04 86 KE J (&P @
% SingleFroc
TF ParallelProc
5 Assembly
Dismartle Station
PickAndPlace

Store .

PlaceBuffer .

Bufer EventController I I
Sorter I

Line ' Method mtd_CriarPedido

ap BT My R (000 EDED SR

[£]
[£]
)

m

10IE @

=

|01 B

S AngularConverter
[=1==]

& Tumtable
() Tumplate EE i

3 TwoLaneTrack ) Sorte
woLaneTrad tf_entrada Sorter

]

€ FlowControl

S

== Cycle

{35 Materizl_Flow

-] Resources il

Favorites v I X
g5 Addto Favortes EE

tf dados

M mtd_CriarPedido gFramel 175%) X ‘v
v 1 x

Consale
Erorin method * Models. Frame 1.mtd_CriarPedido’ in line 7: Unknown identifier mu_pedida a

W
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- 8Xx

g File View Debugger Tools Window Help

5 5 @ [EEEET e 00

Class Library w» & X Toolbox
At Basis (280) || Material Flow ‘ Resources | Information Flow | User Interface | Nobile Unilsl

-] MaterialFlow .
N=58)r b 1 BBEEG
@ EventController _ =

£ Frame

b Interface £ Edit Navigate Objects Icons View Tools Help .

7 o BEoE GwMew 08 2a%i 7 a]

-+ Drain

5= SingleProc

TH ParzllelProc

TR Assembly

& DismantleStation
(% PickAndPlace 3

%g}::tauﬂer . s M X M .| & ModelsFramelSorter Lléj

gﬁuﬁer EventController Navigate View Tools Help

&5 Sorter . —_—

= Line Method mtd,cnan Name: | 85 O Failed Entrance locked ]

= AnguiarConvester

& =

) Tumplate ’ EE

Ez —_ Attributes | Times | Failures | Controls | Exit Strategy |

B TwolaneTrack : t entrada - ; . i . . . . .

oy . - | = <= oCapacity = 1 (infinito) - -
{33 Matenzl_Flow Order: Ascending ~ O

?'QE?““’““_ 2 Time of Sort: OnEntry x| O . . -

- EE | = e o0 <= Quando selecionado quebra a hierarquia

f‘} Add to Favorites

ap HE i By R D @D RN D
- 0%

Label: O |Planned = Exitlocked O

Statistics | Energy | User-defined Attributes |

tf—dados Start Sorting
0K | [ Canced |[ Aoy |
\
[Mmtd_Criarpedido | £ Framet (175%) x i
Console v @ x
Ermorin method " Models. Frame 1.mtd_CriarPedido’ in line 7: Unknown identifier mu_pedido a
V
Pl [
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g File View Debugger Tools Window Help _8x

S5 dd @ e o ap o sk By L 23 DO O
Class Library » I X Toolbox
A E;S'S (2/80) Materizl Flow | Resources | Information Flow | User Interface | Mobile Units |
-] MaterialFlow 2 —
== Connector .D—)—n :J ’ J.; ..J [N ,{j}, ,ﬂ., ,_-ﬂ_, @:
-¢%y EventContraller — = — =
£ Frame
- B Inteface £ Edit Navigate Objects Icons View Tools Help _ax
-+ Source o @ o e
-+ Drain E(cr_i'l“)é}i«b» ﬁ{!{:&ngﬁ
= e
- SingleProc
T} ParallelProc
B8 Assembly
-3 DismantleStation
~(Z FickAndFlace
- Store

N . MNavigate View Tools Help
3 Buer EventController - I I ' I I - ' Name:  Sorter O [Faied Enrzncelocked [

&= PlaceBuffer

- Sorter . . . . . .

= . . Label: O |Planned + Exit locked ]
= Line Method mtd_CriarPedido =

AngularConverter

»

& Models Framel.Sorter

m,

| Statistics | Energy | User-defined Attributes
Attributes ‘ Times | Failures | Controls I Exit Strategy

= Converter

-2 Tumtable EE
(D Tumplate EE
B Track el
3 TwolaneTrack

-EB FowControl

2 Cycle

-{%] Material_Flow

-] Resources i

Capacity: -1 B

Order: Descending AMRE]

Time of Sort: 0On Access MRE!

tf_entrada Sorte

Sort criterion: |MU-PruDerty v| B |User-deﬁnedﬂt‘tnbute MRS

=T tempo_prac| B

Favorites v I X
E,;'a Add to Favorites EE Start Sorting
tf dados

OK | [ Cancal | [ fes |

£ Framel (175%) X 30

Console v I x
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g File View Debugger Tools Window Help _8x
=2=mn" K- i) e o DD
Class Library w I X Toolbox v I x
P Eﬁls (2/80) Materizl Flow | Resources | Information Flow | User Interface | Mobile Units |
-] MaterialFlow o | e B B = B s | — e —_ T -+
-] Resources B3 :J | I I @: pEs DEo Gp ol ey ST @ LTl
3 . = — s = —_ = — Y — Ll ==5
#-(] Irformation Flow
-] Userinterface
=] MUs £ Edit Navigate Objects Icons View Tools Help -8 X
H# PRV A
Y o C DME R O d A EE S =]
Openin3D
=l Duplicate
Derive k'
Cut Inheritance
Delete 1tController
Rename .
Method mtd_CriarPedido
Show Origin -
Show Inheritance == =1
Show MU Statistics EE 1
| —_
Show Attributes and Methods . .
tf_entrada Sorter
Edit Icons... . .
Print...
Find Object...
Favorites [~ =7
Save Object As... EE
g5 Adurevone
tf dados
i framel 175%) X 30
Console v I x
Intt ... -
Reset
W
4 )

Creates a class which inherits from this dass
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g File View Debugger Tools Window Help -2 x
55 Hd [EEEE 8 & e o R

Class Library v B X Toolbox v ax

A Basis 280) Meteial Flow | Resources | Informstion Flow | User Inteface | Mobie Unts

-] Material Flow 2 — = — —

#-(] Resources .D—)—n :-) } J.; .’J [N ,{j}, ,Q ’jj’ @=
-] Information Flow [l ey ]

+D Userlnterface

=1 MUs g Edit Mavigate Objects Icons View Tools Help - X

WE @ e 08 QA %E a2

B

EventController I I I I

tf entrada Sorter

Favorites v 1 x =1=-]
BE
tf_dados

£ Framel (175%) X o

Console * I X
Int ... -
Reset ..
W
7 [
Ready CAP NUM SCRL
20:55
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g File View Debugger Tools Window Help _Bx
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Class Library v I X Toolbox - 3 X

& [Ejasis 2/80) Material Flow | Resources | Information Flow | User Intedface | Mobile Units |

3 Material Flow 2 — ———

-] Resources D—)—n :-) | R e e @:

-] Information Flow ==

#-(] Userlnterface

w Transporter

{&¥] Mobils_Units

g Edit Mavigate Objects Icons View Tools Help -8 X

WEG s SMEM & AR A

-H[E o
=1 Models pen
H Fra Openin 3D
Duplicate
Derive
Cut Inheritance
Delete

Rename

Show QOrigin

Show Inheritance

Favorites Edit Icons...
dh Addi Print...
Find Object...

Save Object As...

Show MU Statistics
Show Attributes and Methods

iController M

Method mtd_CriarPedido
E .

tf entrada Sorter

i 4

B

Renames this class

£ Framel (175%) X 4 b

Console * I X
Int ... -
Reset ..

W

r C
CAP NUM SCRL
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Class Library w 0 X Toolbox v 3 X
A Basis (2780) Material Flow | Resources | Information Flow | User Intedface | Mobile Units |
-] Material Flow 2 — = — —
3] Resources s> [ P+ 2| vmeEe R B @=
-] Information Alow === =
#-(] Userlnterface
_D MUs g Edit Mavigate Objects Icons View Tools Help -5 X
' BR s SMew 0800 %E ] a2
EventController I I I I
Method mtd_CriarPedido
=
(|
. . Rename PR
tf entrada Sorter
Mame:  MU_pedidos =
Label: O
Favorites v 1 x ==
\ﬂ;\ Add to Favorites EE
tf_dados
£ Framel (175%) X o
Console * I X
Int ... .
Reset ...
W

}
CAP NUM SCRL
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Class Library ¥ I X Toolbox > I X
& ‘Ejaﬁls (2/80) Materizl Flow | Resources | Information Flow | User Interface | Mobile Units |
-] MaterialFlow 2 —1 0 e
-] Resources 3-a :J ’ J-D -DJ i b{j}b >Q+
#-(] Information Alow ===
-] Userinterface
=] MUs £ Edit Navigate Objects Icons View Tools Help -8 X

HE s Db 04 Q0 %57

w Transporter
5] Mobile_Units
Lol MU_pedidos «
-D Models # !
L Framel -
EventController - I I ' I I
Method mtd_CriarPedido
=
| | ==l
tf_entrada Sorter
Favorites * @ x ===
BE
tf dados
£ Framel (175%) X 30
Console v I X
Int ... a
Reset
W
1 )
Ready AP NUM SCRL
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Class Library » I X Toolbox v I x
43 Basis (2/80) Material Flow | Resources | Information Flow | User Interface | Mobile Units
-C1 Wateralflon < l . I I ,_|| — l p—
(Z] Resources R :_’_j ’ J.; ..J [ ,{j}, ,_-ﬂ., @:
-] Information Flow — =l =
(Z] Userlnterface
=] MUs £ Edit Navigate Objects Icons View Tools Help -8 X
HE s Db 04 Q0 %57
w Transporter
5] Mobile_Units
Lol MU_pedidos
-] Models ;
o Framel -
EventController I I ' I I
Method mtd_CriarPedido
B2
L] =
tf_entrada Sorter
Favorites v I X ==
BE
tf dados
i framel 175%) X 30
Console v I x
Intt ... -
Reset
W
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i e
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ap B G ML R 901 B
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=
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[
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-1y EventController

£ Frame
- P Inteface =

Edit Mavigate Objects

Icons View Tools Help
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I SingeProc

TE ParallelProc

52 Assembly =
& DismantleStation

-(& FickAndPlace

[ Store

== PlaceBuffer

&2 Buffer

-7 Sorter

= Line

-] AngularConverter

Twolane Track

-£B PowControl

= Cycle

%] Materal_Flow

-] Resources u
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Favorites v B x
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EventController

£ Framel (175%) X

Console

et ...

Method
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-4y EventController e
£ Frame
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~|+ Source i 2| @ Q%
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Objects & Methods

Verificacao
Objetos — disparam o método

Contro/ — quais métodos devem ser executados e
quando devem ser executados
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Consideracoes
Methods of All Objects

1) Todos os objetos acionam os métodos descritos. Sub-capitulos sobre a lista de métodos
adicionais que se aplicam a esses objetos.

2) Um metodo consulta a informacédo de um objeto e retorna um valor. O método calcula um
valor e dé& inicio a uma ou algumas ac¢des que controlam o comportamento do objeto. Os
métodos sdo agrupados de acordo com as suas funcgoes.

Um exemplo de uma linha de Sintax de um método individual:

Syntax: <Path>.openFile(FileName:<string> [,NoDebugger:<boolean>]);
« A expressao <Path> designa o caminho do objeto para o qual o método se aplica.
« O tipo de dado dos parametros € listado entre parenteses.

« Os sinais menor < e maior do que >. A expressao (Parameter:<real>), por exemplo, designa
um parametro de tipo de dado real. A expressao (byRef X:<integer>), por exemplo, designa
uma variavel do tipo de dado inteiro.

3) Em vez de um valor constante, vocé também pode usar uma variavel do tipo requerido ou
um método que retornar o tipo de dado requerido.

4) Parametros adicionais sdo listados dentro dos colchetes (square brackets). A expressao
[,Parameter:<boolean>], por exemplo, significa que vocé pode, mas nao tem de entrar o
parametro boolean.

* Torna segura entrar com 0s parenteses das expressoes dentro dos parenteses (...).
Nenhuma entrada deles pode conduzir a resultados inesperados e abrir o Debugger. |,
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Home Imprimir Opglies

Digite a(s) palavra(s) a pesquisar:
method
Listar Tépicos

Selecione topico: Localizado: 500

Titulo lo... Classficag *

Working with the Di... Te
Suspending Methods
Create and Delete ... Te...
Methods of the Met... Te..
Methods of the Mat. . Te
Toolbar of the Meth... Te...
Methods of Lists an... Te...
Methods of All Obje... Te..
Toolbar of the Meth.. Te
Exception Handing ~ Te...
Auto Complete Te...
Method Te..
Working inthe Met... Te
Methods of the Tab... Te..
Method Debugger Te...
reset Te..
Program the Cortrol... Te:
The watturtilstatem_. Te
Reactivating Metho... Te..
Simuftaneously Rea... Te..
Methods of the Tra... Te..
Show Attibutesan.. Te
addObserver Te..
Methods of the Vari.. Te..
Methods of the Tw... Te...
Exchanging Data vi... Te
Methods of Al Mobi... Te...
Add Te..
Method Te..
Methods of the Tim
Methods of the Line ~ Te...
Methods of the Track Te...
Methods of the Tur... Te..
Methods of the Tur . Te
Methods of the Muk... Te...
Create Sensors Te..
Methods of the Con... Te...
Methods of the Drain - Te:
Calling a Method Te...
Methods of the Par... Te..
Methods of the Pic... Te..
Methods of the Pla..  Te
Methods of the Sorter Te...
] m

[~ Pesquisar nos resultados anteriores
| oincidir palavras semelhartes
|| Pesquisar apenas ostfulos

Reference Help > Material Flow Objects > Shared Properties of the Material Flow Objects > [T

of All Objects

All objects share the [EIILE described below. The sub-chapters about the objects list additional [E{I0es that apply to these objects.
AE— E T queries information from an object and retums a value. It calculates a value and starts one or several actions that control the behavior of the object. We grouped the [IE2R according to their functions.

An example of the Syntax line of the individual [ERERE might look like this:

Syntax: <Path>.openFile (FileName:<string> [,NoDebugger:<boolsan>]);

+ The expression <Path> designates the path of the object to which the [T applies.

« The data type of the parameters is listed in parenthesis between the less < and the greater than > signs. The expression (Parameter:<real=), for example, designates a parameter of data type real. The expression (byRef X:<integer=),
for example, designates a variable of data type integer.

Instead of a constant value, you can also use a variable of the required type or a [0 that returns the required data type.

Optional parameters are listed within square brackets. The expression [ Parameter-<hoolean>], for example, means that you can, but do not have to enter the boolean parameter.

0 Make sure to enter the parentheses for expressions within parentheses (...). Not entering them may lead to unexpected results and open the Debugger.

To view all of the [EURLE and attributes of the material flow object, open the window Show Attributes and [TEGIRE. The figure below illustrates the information using the example of the object Source.

I+ Models.WorkenitControl.Source
ElamMS9E
Name Value . Signature
ContentsList i} {[Contents:table]) : any
Coordinatz3D [8,2,0] i array
copyToClipboard
createAttr {AttrMame:string, DataType:string) : boolean
createlcon {[IconMame:string, Width:integer, Height:integer]) : integer
CreateIn3D boolean
createObject {Destination:object, ¥Pos:integer, YPos:integer [, Name :string]) : ohject
CreationTable {CreationTable:table)
CreationTableActive false i boolean
Currlcon Operational i siring
CurrlconMo 1 i integer

CurrlconTransparent true i boolean
delAniPaint {AniNo:integer) : boolean
delaniPoints boolean
[(atrame:string): booean
Identifier and data type of Data type of the

Name of the method the parameter you enter return value

« Select Show Attributes and m on the context menu of the Class Library to show the atfributes and IIEIERE of the selected Class.
* Press the F8 key or select Objects > Show Attributes and m in the Frame into which you inserted an instance to show the atfributes and [T of the selected Instance.

08:54
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